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Serial Plates 

All enquiries should be directed to: 

SPIDA Machinery Ltd 

Australia free phone 1800 146 110 

America free phone 1888 262 9476 

NZ free phone 0800 SPIDAS or +64 7 343 7915 

Below is a copy of the serial plate displayed on the back of the machine 

 

 

WARNING 
This machine must only be used by personnel who have been 

properly instructed in all aspects of the machine’s safe operation. 

Operators must also wear the recommended personal protective 

clothing and have thoroughly read and understood this manual. 
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2 Overview 
The Spida Rapid Stop is designed to accurately measure timber, or other materials, up to 6000mm in 

length. 

The Rapid Stop test procedures must be performed at installation and after any maintenance, 

adjustment, repair, or modification to the machine.  The test procedure is available on request.   

Only qualified personnel must install and test the Rapid Stop. 

Do not perform any tests or repairs other than those outlined in the manual. 

The Operator must also regularly perform (at least every three months but more often if used 

continuously) the recommended maintenance procedures. 

All electrical wiring must be set so as not to allow its movement through the cutting area of adjacent 

machinery.   

All Operators should read this manual before operating the Rapid Stop to ensure they are 

thoroughly familiar with the proper operation of the Rapid Stop controls, features, capabilities and 

limitations. 

This manual offers many safety tips, but its purpose is not to provide instruction in all the skills and 

techniques required to manufacture timber safely. 

Due to improvements in design and performance during production, in some cases there may be 

minor discrepancies between the actual machine and the illustrations and text in this manual.   

 

3 Specifications 
 

Table 1, Rapid Stop Specifications 

Overall Width 515mm 
Overall Height 984-1144mm 
Overall Length 6590mm 
Working Width 395mm 
Working Height  818-978mm (Adjustable) 
Working Length 6100mm 
Fence Height 115mm 
Weight 320 kg 
Operational Noise -  
Timber Feed Left or Right 
Monitor centre height  1470mm 
Electrical Supply  15 Amp 240V Single Phase 
Servo Motor 2.94Nm, 5000 RPM 
Servo Drive Ultra 3000 5A/15A Index 

 

Specifications may change without notice 
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4 Installation 

4.1 Handling & Transport 
 Box all additional parts and secure with the machine 

 Using a single fork truck, lift the machine package underneath using the forklift spaces 

provided 

 Once on the truck, tightly strap the machine. 

 Do Not place any loads on top of the machine 

 The machine should be kept free from road grime and rain, and should be covered at all 

times while being transported 

4.2 Installation 
 It is advisable to forklift the machine package as close to the final assembly point as possible 

to reduce manual lifting 

 The final operating position of the machine must be free from any rubbish or impediments 

 There must be good lighting in the installation area to allow proper positioning of the 

machine 

 The ground on which the machine rests must not vary by more than 30mm over a 12m x 2m 

area 

 Rapid Stop table should be leveled using the adjustable feet. Once level, machine should be 

bolted to the floor through holes provided. 

 Electrical commissioning to be to local standards and be performed by a qualified electrician 

 

The site selected for the Spida Rapid Stop will depend on the ground. The ground chosen should be a 
clean and free of water or possible flooding. The area on which the framework sits must be as even 
and horizontal as possible. This can be achieved by adjusting the length of the feet. There should be 
no twist to the framework when the feet have been adjusted to take the ground 
into account. 
 
The final operating position of the machine should be free of all rubbish or impediments with 
general access to all areas of the Rapid Stop for the ease of loading and unloading of timber. 
 
With the machine in position, a qualified engineer should be used to connect the electrical 
components to the machine. 
 
Check that all safety equipment is functioning properly.  
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5 Safety 
This Spida Rapid Stop is built for providing an efficient and safe means of measuring and cutting 

timber. The Spida Rapid Stop must only be used for the purpose specified above and must be set up, 

maintained and operated in accordance with the instructions contained in this manual and the best 

standards of industrial machinery practice.  

This Spida Rapid Stop will perform better and have a longer life if it is operated with care and given 

regular maintenance and inspections. 

PROTECTIVE SAFETY CLOTHING AND EQUIPMENT MUST BE WORN; INCLUDING: 

 Eyewear 

 Hearing protection 

 Respirator or Dust mask 

 Protective Clothing 

The Spida Rapid Stop must only be operated by personnel who have been properly instructed in all 

aspects of the Spida Rapid Stop safe operation. 

Each member of the factory personnel shall be instructed in the safe use of the Spida Rapid Stop 

using this manual as a guideline and shall sign a copy of this manual to indicate that he or she has 

been instructed in the safe operation of the Spida Rapid Stop and have thoroughly read and 

understood this Manual and any other additional information that has been supplied. 

A copy of this manual will be placed in the personnel file of each employee that receives instruction 

on the Spida Rapid Stop. 

A second copy will be made available to each employee for his or her reference. 

This manual is intended as a guide for safe operation of the Spida Rapid Stop by the operator.  The 

operator should not consider this manual as all-inclusive. 

Should you have any questions on the Spida Rapid Stop contact SPIDA Machinery (SM2012 Ltd). 

 Protective clothing is to be worn at all times whilst operating this machine. The machine has 
several moving components which may snag any loose ill-fitting clothing resulting in possible 
injury. Keep hands away from all moving parts. 

 Stay alert at all times of any human movement around the machine. Know where your co-
workers are when you are operating the machine! 

 Use the correct operating procedure to switch the machine off when it is not in use 

 Before the commencement of work: 
o Carry out a general inspection of the machine for loose fittings, fasteners and 

damage to the electrical wiring. 
o Check all safety systems and equipment are work properly 
o Ensure that the machine is not vibrating or making unusual noises 

 When shutting the machine down after each shift remove any foreign objects such as tools, 
discarded nails etc. 

 Long hair should not be worn around the machinery. Wear appropriate hat or hair net, 
which will cover loose hair in accordance with OHS regulations. 
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 All maintenance should be carried out (where possible) with the compressed air and 
electrical supply isolated. 

 The operator shall be suitably trained in accordance with this manual1. 

 Any person under the influence of alcohol or any drugs which would impair the operator’s 
normal functions shall not operate the machine2. 

 It is the responsibility of the competent operator to prevent any other person from coming 
into the operators work area whilst the machine is in use. 

 Observe and obey all warning decals and labels. 
 

When initially locating the machine in the factory production area, due care and attention should be 
given to a clear working area around the machine and the movement of timber into and away from 
the working area. Operation of the machine should be confined to competent trained personnel 
only, (Ensure they sign the Operation/Maintenance Manual) who are responsible for routine 
inspection of components and ensuring that the machine is not in an unsafe condition. 
 
Notes: 
 

1 It is recommended that the employers maintain training records demonstrating the 
competencies of each employee  

2 Consult a doctor or a pharmacist if you are on or taking any medication that you are 
unsure about. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

WARNING! Do not operate the Spida Rapid Stop without having received the 

proper instruction in operation and safety from this manual. 
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6 Operating Controls 
Before attempting to operate the Spida Rapid Stop, familiarise yourself with the location and 

function of each control. 

 

Figure 1, Rapid Stop Controls 

Table 2, Control functions see Error! Reference source not found. 

Control Function 
A Operator Input Touch Screen 
B Emergency Stop Button 
C USB Port 
D Quick Clamp Lever 
E Emergency Stop Button 
F Main Electrical Isolation Switch 
G Main Electrical Control Box 
  

 

WARNING! The emergency stop will disable the machine indefinitely unless 

problem is addressed. Don’t non operate the Rapid Stop without the correct 

knowledge and function of each of the controls. 
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7 Software Operation  

7.1 Saw Operation 

7.1.1 Software Protection 
This program is protected by a USB Hardware Key to prevent unauthorized copying of our software. 

Please ensure you protect your Hardware Key as the value of the software is in the Key, and you will 

be charged for a replacement.  

If you have problems with your Key the software can run on a Temporary Activation while a new Key 

is shipped to you. 

To run using a Temporary Activation, press Ignore 

when prompted for the Hardware Key, and then ring 

SPIDA for an authorisation code for your computer.  

Note: you will only be able to run for a very limited 

time on a Temporary Activation so you will need to 

order a replacement key ASAP.  

7.1.2 Getting Started 
Turn on Control Cabinet and make sure the UPS and computer start up.  If not turn them on also.  

The computer will boot and load Windows then the CSS software.  Once loaded the following 

question box will be displayed: 

Check that all lumber placed on the bench is out of 

the way of the trolley then press Yes to enable and 

home the Trolley. 

 

 

7.1.3 Open Job File 
 

Click on the Open Job Button (or select 

"Open Job" from the File Menu) to open the 

Open Job File dialog box. 

 

Then Select the job and click “open “.  If the 

job file is on a removable disk, insert the disk 

and select "Copy Jobs from Removable 

Media (X:\)" from the File Menu.  
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7.1.4 Main Screen 
Once a job is opened the main screen will be populated with the cutting file, a picture of the first 

member will be displayed at the bottom of the screen and the first panel/truss drawing will be 

displayed at the top. 

 

NUMBER BUTTON FUNCTION 
1 Menus Select menus 
2 Trolley Position Shows trolley position 
3 Enable Powers up servo drives 
4 Disable Turns servo drives off 
5 Cutting Mode Tabs Auto, Semi, Manual 
6 Member Selection Currently selected member 
7 Start Starts selected member 
8 Done - Toggle Changes member status from done to not done 
9 Swap Swap member end to end 

10 Saw Angle Shows required saw angle 
11 Select Member Arrow button to move through member list 
12 Open Open job button 
13 X1 X1 changes to X10 allowing movement through list by number 
14 Full Screen Toggles full screen 
15 Saw Saw not applicable to Rapid Stop 
16 Servo Opens servo control to reset, home or disable trolley 
17 Flip Roll member over 
18 Member Member picture with length, size and grade 

 

1 3 1 4 1 2 1 1 1 0 

1 

2 

3 

4 

5 

6 

7 

8 

9 1 5 1 6 1 7 1 8 
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7.1.5 Using the Saw 
Each of the following three operations can be selected from the main screen by clicking on the 

appropriate tab. 

7.1.5.1 Auto Operation 

 

By opening the job from the Job File, the main screen will display the cutting information for the 

current job. Select the member you wish to cut from the list by touching that line or by using the 

arrow keys to scroll between members. Once you have selected the member ensure the positioning 

servos are enabled by checking the box next to Enable - this should become green.  By pressing the 

“Start member” button the trolley will move to the desired position in preparation for cutting that 

member. 

7.1.5.2 Semi Auto Operation 

 

The user can create or change a member with up to 6 angles and 4 offsets 

7.1.5.3 Manual Operation 

 

Manual Operation allows you to enter one length. By entering a value into the trolley position box, 

the user can make a single cut at the desired position. By selecting “Start member” the trolley should 

then move to the desired position. 
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7.1.6 Using the Screen Keyboard 
The screen keyboard provides a means of entering data using the touch screen.  When you click or 

touch input boxes the screen keyboard will pop up. 

 

The Screen Keyboard changes depending on the type of information that is valid for the box 

selected. 

7.1.6.1 Numeric Data 

Allows you to enter a decimal or imperial F-I-S value. 

 

 

 

 

 

 

7.1.6.2 Alphanumeric Data 

Much the same as for the numeric keyboard with the addition of Alpha and in a standard QWERTY 

keyboard layout. 

 

 

 

 

 

 

Button Button Function 
1,2,3,4,5,6,7,8,9,0 Numeric Keys 
- Insert Dash for Imperial 
< Backspace Key 
CLR Clear Entry 
Enter Accept Input and Close Keyboard 
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7.1.7 Servos 
The Servos are the small motors in your Rapid Stop that control the positioning of the saw and 

trolley. 

They are a very accurate device that can position their output shaft to within 0.1 degrees. This 

output is then run through a gear drive which increases the accuracy even further. There are some 

mechanical losses in the belt drive and chain drives that control the actual position of the saw and 

trolley but accuracy of 0.01 degrees or better than 0.1 mm are still achievable on a well-maintained 

system. 

Calibration on the servos is performed in the setup screen under the “Trolley” and “Saw” tabs. 

 

7.1.7.1 Enable 

This will enable the servo.  When enabled a servo will 

maintain its position and effectively lock onto the correct 

position.  The green light will indicate next to the Enable 

button when the servo is enabled. 

7.1.7.2 Reset 

When disabled you can move the trolley or saw by hand.  

The servo will feedback the position but not control the 

position.  The green light will indicate next to the Disable 

button when the servo is disabled. 

7.1.7.3 Home 

This will home the servo to a homing proximity sensor 

located on the machine. The red light next to the Home 

button will change to green when the servo is homed. 

 

 

 

 

 

 

 

 

 

Warning: the servo will move at a slower speed towards the homing proximity 

sensor to locate a known position (as setup in the “Saw” or “Trolley” tab of the 

setup screen). 
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7.1.8 Converter 
The converter will convert imperial and metric values.  

Use the Screen Keyboard to enter the number and the units that 

you wish to convert from and the units to convert to then press 

the “Convert" button. 

 

 

 

7.1.9 Diagnostics 
The Diagnostics window allows the operator 

to quickly check the state of the relevant 

inputs and outputs, this expatiates any fault 

finding. 

 

 

 

7.1.10 Updating Software 
Download the latest update from http://www.cyberlogix.co.nz/spida. 

Run the setup file and follow the on-screen instructions. The current configuration settings in 

CSSConfig.ini will be retained so there should be no need to recalibrate, etc. 

7.1.11 Reinstalling Software Using Ghost Disk 
Before installing new software using a Ghost disk, it is important that before you begin the 

configuration file is copied to a floppy disk. This way the current settings on your CSS software will 

be recovered.  The file CSSConfig.ini is located under the main c:\ root directory. 

Insert the Ghost disk into the drive and restart the computer following the onscreen instructions. 

When the installation is complete, copy the CSSConfig.ini file back into the main c:\ root directory.  

All previous configuration settings should now be retained. 

Because Ghost disks are created less frequently than software versions it may be necessary to 

update the software after reinstallation. 

 

 

 

 

 

http://www.cyberlogix.co.nz/spida


 
 

 
 
16                                                                                                                      Operations Manual – Rapid Stop 
 

7.2 Saw Setup 

7.2.1 Accessing Setup 
To access the Setup screen, click on the "Tools" menu at the top of the screen and then "Setup “.  

You will be prompted for a username and password. When you click on the username or password 

boxes a Screen Keyboard will pop up so that touch screen users can enter in the required 

information. When you have entered the username and password click on “OK” to open the setup 

screen.  

The setup Screen consists of the following tabs: 

General Tab Trolley Tab Saw Tab File Tab Colors Tab Security Tab 
 

7.2.2 General Tab 
The General Tab enables you to set the following items up for your saw: 

 

7.2.2.1 Trolley Side 

When looking at the saw from the operating position this setting determines which side the trolley is 

on in relation to the saw.  

7.2.2.2 Display Units 

Metric or Imperial. This setting will determine how files are displayed on the screen regardless of 

how the file was created or saved i.e. if a file is created in metric but you select imperial the file will 

be converted and displayed in imperial.  

7.2.2.3 Language 

Selects the language format.  

7.2.2.4 First Cut Waste 

This setting is used when drawing the member on the screen - it has no effect on the cutting of the 

members. 
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7.2.2.5 Cut-list Column Widths 

Set to Default - Defaults to the custom member column width setup. Save Current - Saves the 

current member column widths. 

7.2.3 Trolley Tab 
The Trolley Tab enables you to set the 

following items up for your saw: 

7.2.3.1 Soft Limits 

These are the upper and lower limits to 

the travel of the trolley. The trolley will be 

able to travel to these limits but not 

beyond during normal use.  

7.2.3.2 Home Position 

This is the measurement from the flange 

(or motor) side of the saw blade to the 

trolley pusher after it has completed its 

homing sequence. 

7.2.3.3 Calibrate 

This button will start and walk you through the Calibration of your trolley. Use this procedure if your 

saw is not cutting accurately.  

7.2.3.4 Positioning 

These settings control the speed and acceleration/deceleration of the trolley.  You can also set the 

number of pulses per mm for the servo.  This is the number of encoder pulses for each mm of travel 

and is normally around the 299 setting. Manually setting this is not normally required as the 

calibration procedure will set this.  Changing this setting will affect the accuracy of all measurements 

of the machine and if set incorrectly can cause the Trolley to travel past the soft limits as set above. 

7.2.3.5 Tuning 

These should only be changed when instructed to do so by SPIDA or Cyberlogix - serious machine 

damage and/or personal injury can result if inexperienced personnel change these settings.  

7.2.4 Saw Tab 

7.2.4.1 Soft Limits 

These are the upper and lower limits to 

the travel of the saw rotation.  

7.2.4.2 Saw Gauge 

This feature compensates for the 

thickness of the cutting blade installed 

on the saw. 

7.2.4.3 Position, Home Position, 

Calibrate 

Not Applicable to Rapid Stop. 
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7.2.5 Calibration 

7.2.5.1 Trolley Calibration 

To calibrate the trolley lengths access setup and select the “Trolley” tab.  Then click “Calibration” 

and you will see the trolley calibration screen.  This calibration will adjust the "Pulses Per mm" on 

the “Trolley” tab.  

Follow the instructions on the screen to calibrate the trolley. 
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7.2.6 File Tab 
The file tab enable you to set the following items for your saw 

7.2.6.1 Default File Extension 

Select the most commonly used file extension for your site. 

7.2.6.2 Default Job Path 

This is the path that the 

operator will be taken to 

when they open a job - the 

operator can browse to other 

locations but every time they 

select “Open Job” this folder 

will be selected. 

We do not recommend that 

you store your jobs on a 

remote machine. The Default 

is C:\SpidaJobs.  For system 

safety, the job folder must 

contain the word "jobs” 

before the auto delete 

function will operate.  

7.2.6.3 Removable Media Path 

This is the path to your removable media that you typically use for transferring jobs to this 

computer. When the operator selects “Copy Files from Removable Media” from the File Menu then 

all files in this location will be copied into the default job path as specified above.  

7.2.6.4 Options 

Use MME Compression: 

Select this option to use the similar member compression available in the Mitek MME format (it will 

have no affect for any other file types). 

Swap member ends on load: 

This option is mainly for plate marking.  If the marks on the plate don't match the panel image, then 

this will reverse all plates on loading of the job. 

Skip Selected Marks (MME): 

Any marks/trenches preceded with a tilde ~ symbol will be excluded. 
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7.2.7 Colors Tab 
Used for changing the default colors in job list. 

For Timber Size Colours type in 

the timber size then press the 

dotted button beside the cell to 

select a colour. Once selected 

timber of this size will then be 

written in this colour on the 

main screen. 

Selected Row, Cutting Row, and 

Row Done can be custom 

coloured by pressing the 

dotted button next to the cell 

you want changed.  You can 

also specify white text if the 

colour chosen is dark. 

 

7.2.8 Security Tab 
Enter the user name and a 

password for each user. 

Checking either the Setup box 

or the Report box will allow the 

user to access the setup menus 

or access the reports. 

Checking the Require Password 

box will require an operator to 

logon before being able to run 

the machine. 
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7.3 Menus 

7.3.1 File Menu 

7.3.1.1 Copy Files from Removable Media 

This will copy the files from the removable media 

path selected in the Setup File Tab. 

To change which removal media device is used, 

change the option in Tools>Setup>File Tab. 

7.3.1.2 Open Job 

This will open the Open file dialog box so that you 

can Open a Job File.  

7.3.1.3 Auto Delete Jobs Over 30 Days old 

When a job has not been accessed (opened or used for cutting) for over 30 days then the job will be 

deleted from the job folder (turn on this option through the Setup File Tab). 

For system safety, the job folder must contain the word “jobs” (in upper or lower case) before auto 

delete will be performed. 

7.3.1.4 Exit 

This will shut down the CSS software and return you to the Windows desktop.  

7.3.1.5 Shut Down Computer 

This will shut down the CSS software and show the Windows shutdown dialog box so that the 

computer can be shut down or restarted. 

7.3.2 Tools Menu 

7.3.2.1 Servos 

This will take you to the Servos Screen.  Alternatively 

clicking 'servos' at the bottom of the main screen will also 

take you to the servos screen.  

7.3.2.2 Converter 

This is a imperial and metric Converter to convert from 

any units to another unit.  

7.3.2.3 Login 

When activated (through the Options>Setup>Security Tab) 

this requires users to login before they can operate the saw.  

7.3.2.4 Logout 

This will logout a registered user after they have finished using the saw to prevent unauthorised use 

of the machine. 

7.3.2.5 Diagnostics 

This enables the user to locate and diagnose a fault with a machine. 

7.3.2.6 Setup 

This provides a number of tabs for setting up different aspects of the CSS machine and software. 

More in Accessing Setup . 
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7.3.3 Option Menu 
All options are enabled when the tick is next to the option. Clicking the option toggles the tick.  The 

options are saved and will be recalled when the software starts. 

7.3.3.1 Auto Flip for Safest Cut 

This setting applies to trusses only and has no effect on plates.   

The member will be flipped when the cut would be wedging the waste into the saw on the saws 

return stroke.  

7.3.3.2 Auto Swap for Easiest Cut 

This setting applies to trusses only and has no effect on plates. 

The member will be end swapped when the first end cut is calculated to be harder for an operator to 

perform than the other end i.e. a single cut end will be the first cut if available.  

7.3.3.3 Under Cut Length 2mm 

2 mm. will be undercut all members 

7.3.3.4 Auto Stop When Marking 

This setting applies to plates only and has no effect on trusses. 

The saw will stop when the last cut is performed on a member before any marking is started.  This is 

preferred by some operators for safety when marking.  

7.3.3.5 Next Move Auto (When saw back) 

When the saw is returned to the fully retracted position the saw and trolley will auto setup for the 

next cut. 

7.3.3.6 Next Member Auto (When member complete) 

When the member is fully completed (the quantity required is also cut) the next member in the list 

will be selected for you. You will still need to click Start Member before the saw will setup for this 

member. 

 

 

 

 



 
 

 
 
23                                                                                                                      Operations Manual – Rapid Stop 
 

7.3.4 Member Menu 

7.3.4.1 Go To 

First - goes to the first member in 

the cutting list. 

Last - goes to the last member in 

the cutting list. 

 

 

7.3.4.2 Find 

To find a member in the cutting list enter all or part of 

the members 'Panel' identification code or its 

'Member' name.  Press the Find Again button if you 

wish to find the next member in the list with a similar 

name. 

7.3.4.3 Flip Board Vertically 

This flips the member vertically.  Alternatively, the “Flip” button on the main screen can be used. 

7.3.4.4 Swap Ends Horizontally 

This swaps the member horizontally.  Alternatively, the “Swap” button on the main screen can be 

used. 

7.3.4.5 Toggle Done Status 

This toggles the selected member as being completed or not. A completed member can be toggled 

off if it needs to be recut, or a yet to be cut member can be toggled on if it is no longer required. 

Alternatively, the Toggle button on the main screen can be used. 
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8 Parts Identification 

8.1 Top Level Assembly, 1202RSCOM 

 

Figure 2, Top Level Assembly 

Table 3, Top Level Bill of Materials 

ITEM QTY PART NUMBER DESCRIPTION 

1 1 0605000 Multi Monitor Assembly 

2 1 1202000 Rapid Stop Table (6m) 

3 1 ECOM-WES7G5 Comp. Loaded with Spida Software 

4 1 EEHW Electrical Enclosure Hole and Window 

5 1 EKRS RS Comp Automation Kit 

6 4 HWCSM825 Hex Socket Head Cap Screw M8x25 

7 4 MT21-1351 M8 Sq Nut - Posn Fixing 

8 1 NAMEPLATE Serial Number Plate 

9 2 SMPBKT13 Computer box bracket 
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8.2 Table Assembly, 1202000 
 

 

Figure 3, 1202000 Table Assembly 
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Table 4, 1202000 Bill of Materials 

ITEM QTY PART NUMBER DESCRIPTION 

11 1 1202409 CSS Sensor Block 

21 1 1202412 Ski Jump 

3 14 HWBHM1020 Hex bolt M10x20 

4 1 HWCSM620 Hex Socket Head Cap Screw M6x20 

5 2 HWCSM816 Hex Socket Head Cap Screw M8x16 

6 34 HWCSM820 Hex Socket Head Cap Screw M8x20 

7 20 HWCSM825CS Hex Socket CSK Cap Screw M8x25 

8 2 HWCSM835CS Hex Socket CSK Cap Screw M8x35 

9 16 HWNHM16 Hex nut M16 

10 14 HWWFM10 Washer Flat M10 

11 13 HWWFM8 Flat Washer M8 

121 1 IME12-04BPSZCOS SICK, Proximity Sensor 

13 1 MT21-1330-2 M6 Sq Nut - Posn Fixing 

14 38 MT21-1351 M8 Sq Nut - Posn Fixing 

151 1 MT28.0120 MiniTec Prox Bracket 12mm Dia. 

161 1 SMPBKT01 Sensor Bracket 

17 1 SMPBKT11 Saw Connector Brkt 

18 2 SMPBT3100-450-18 Bench top 3100x295x18 

19 1 SMPGPFA6300 Fence assembly 

20 1 SMPGPGK1 Motor/gearbox kit - Straight box 

21 5782.000 mm SMPGPSG Fence Trolley Guard - Aluminium Extrusion 

22 1 SMPGPTK1 Stop 

23 1 SMPPLT08 Table Connection Plate - Long ver. 

24 2 SMPTB02 Outfeed Table Frame 

25 4 SMPTBF01 SMP - Foot v.1 

26 4 SMPTBL02 SMP - Leg v.2 
 

Note: 

1  Depending on what Machine the Rapid Stop is being used with determines what sensor 

configuration is required. 
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8.3 Fence Assembly, SMPGPFA6300 

 

Figure 4, Fence Assembly SMPGPFA6300 

 

Table 5, SMPGPFA6300 Bill of Materials 

ITEM QTY PART NUMBER DESCRIPTION 

1 4 HWCSM675 Hex Socket Head Cap Screw M6x75 

2 3 HWCSM835CS Hex Socket CSK Cap Screw M8x35 

3 8 HWSSM68 Hex socket set screws M6x8 

4 2 HWSSM825 Hex socket set screw M8x25 

5 4 MT21-1018 Power Lock Fasteners 

6 3 MT21-1351 M8 Sq Nut - Posn Fixing 

7 6300.000 mm SMPGP9045 Guide Profile 

8 2 SMPGPJB81 T-slot bar 180 

9 2 SMPGPPB45 Pulley Block assembled 

10 2 SMPGPTB - 01 Belt tensioner body 

11 2 SMPGPTB - 03 Tension bloc slider 

12 2 SMPGPTB-02 Tension block insert 

13 1 SMPGPTC Tensioner connector 

14 13000.000 mm TRTIB-AT10/32 Timing Belt AT10/32 
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8.4 Trolley/Stop, SMPGPTK1 

 

Figure 5, Trolley/Stop Assembly (SMPGPTK1) 

Table 6, Trolley/Stop Bill of Materials 

ITEM QTY LENGTH PART NUMBER DESCRIPTION 

1 4 1 HWCSM816BH Button Head Cap Screw M8x16 

2 8 1 HWCSM820BH Button Head Screw M8x20 

3 2 1 HWCSM825 Hex Socket Head Cap Screw M8x25 

4 8 1 HWWFM8 Flat Washer M8 

5 2 1 MT21-1018 Power lock fasteners 

6 10 1 MT21-1351 M8 Sq Nut - Posn Fixing 

7 1 710.000 mm SMPGP9045 Guide Profile 

8 1 250.000 mm SMPGP9045 Guide Profile 

9 4 50.000 mm SMPGPDS Slider for GP 

10 2 1 SMPGPEP Guide profile end cap 

11 1 1 SMPGPPP1 Pusher Block 
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8.5 Gearbox Motor Assembly, SMPGPGK1 
 

 

Figure 6, Gearbox Assembly SMPGPGK1 

Table 7, SMPGPGK1 Bill of Materials 

ITEM QTY PART NUMBER DESCRIPTION 

1 1 EMBLY343160V5K BLY3473D Brushless 5000RPM 160VDC 44W Motor  

2 2 HWCSM425 Hex Socket Head Cap Screw M4x25 

3 4 HWCSM516 Hex Socket Head Cap Screw M5x16 

4 4 HWCSM620 Hex Socket Head Cap Screw M6x20 

5 2 HWCSM820 Hex Socket Head Cap Screw M8x20 

6 2 MT21-1351 M8 Sq Nut - Posn Fixing 

7 1 SMPPLT20 Mount Plate GB to Guide Profile 

8 1 TRGB0901-NS-010-12-16 Gearbox - 34 Motor - 12mm input 16mm output 
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9 Maintenance 

9.1 Maintenance Intervals 
Before attempting any maintenance on the Rapid Stop, isolate from electrical supply. 

Table 8, Maintenance intervals 

Check Day Week Month ½ Year 
Belt tensioned x    
Check that work area is clear x    
Clean swarf and off cuts on and around machine x    
Check stop sensor x    
Guards in place x    
Noises or Vibrations x    
Clean aluminium extrusion slots x    
Check timing belt tension  x   
Check emergency stops working  x   
Check Stop for accuracy  x   
Check for loose bolts   x  
Floor bolts for tightness    x 

 

 

Failure to perform these checks as per schedule indicated in Table 8 may result in 

serious damage or a severe accident. Prior to operating the machine make sure 

that the machine is bolted down on a level floor and the drive motor is rotating in 

the correct direction (spindle rotation is to be in a clockwise direction when 

viewed on the front of the tailstock). 

 

 

WARNING! Electrical power supply must be isolated from machinery and 

appropriate danger tagging in place whenever any maintenance is being 

performed on machinery. Any defects, which are found on inspection should be 

rectified immediately and reported to the supervisor for appropriate action. 
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9.1.1 Belt tensioned 
Check than timing belt is at correct tension and free of any obstructions 

9.1.2 Check that work area is clear 
Keep work area clean and tidy and table is free of any obstruction before using Rapid Stop 

9.1.3 Clean swarf and off cuts on and around machine 
Clean and remove saw dust and/or swarf from on and around machine 

9.1.4 Check stop sensor 
Check proximity sensor is not damaged and in correct position, see 9.2 to reposition sensor. 

9.1.5 Guards in place 
Check that all guards are in place and securely fixed 

9.1.6 Noises or Vibrations 
Listen for any strange noises or vibrations and remedy any that occur. 

9.1.7 Clean aluminium extrusion slots 
Keep aluminium slots in fence clean and free of any dust of obstructions. 

9.1.8 Check emergency stops working 
Check that emergency stops are working and stop saw as required. 

9.1.9 Check Stop for accuracy 
To maintain accuracy regularly home and calibrate the Rapid Stop. See section 7. 

9.1.10 Check for loose bolts 
Check for loose bolts and fasteners on covers, leg, guards and table and tighten or replace as 

necessary.  
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9.2 Set Proximity Position 
This maintenance need to be carried out whenever a sensor, lead or bracket is replaced. 

Depending on type of saw the Rapid Stop is being used with determines the configuration of the 

proximity sensor. There are two configurations possible. 

9.2.1 Vector Proximity Sensor Configuration 

 

Figure 7, Vector proximity sensor configuration 

 Power off saw and Rapid Stop. 

 Push the trolley to the minimum position (closest to saw). 

 Loosen proximity bracket screws. 

 Position the proximity sensor to the rear of the sensor bar as shown in Figure 7. 

 Tighten proximity bracket screws. 

 Ensure there is a 1.5 – 2.5mm gap between face of sensor and sensor bar. 

9.2.2 Apollo Proximity Sensor Configuration 

 

Figure 8, Apollo proximity sensor configuration 

 Power off saw and Rapid Stop. 

 Push the trolley to the minimum position (closest to saw). 

 Loosen proximity bracket screws. 

 Position the proximity sensor to the rear of the timing belt tensioner as shown in Figure 8. 

 Tighten proximity bracket screws. 

 Ensure there is a 1.5 – 2.5mm gap between face of sensor and timing bel tensioner. 
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9.3 Change/Replace Timing Belt 
 Power off the saw. 

 Remove all 16 cap head screws from the upright brackets at the rear of the out-feed table. 

 Slide the complete fence away from the saw until the out-feed drive motor is clear of the 

table. 

 Turn the whole assembly upside down.  

 Loosen the belt tension adjusting grub screws in the belt attachment blocks underneath the 

pusher arm. 

 Remove the cap head screws from the belt attachment blocks. There are two screws in each 

block. 

 Remove the belt ends from the clamp blocks in the attachment blocks. 

 Pull the old belt out of the assembly. 

 Remove the grub screws which lock the pully blocks to the guide profile fence (there are two 

- one on top and one at the bottom at each end.) 

 On the drive end, slide the motor assembly together with the pulley block, out of the guide 

profile fence. 

 At the saw end, slide the bearing block clear of the the guide profile fence. 

 With the fence still lying upside down, feed the new belt through the profile with the 

smooth side down until it protrudes from the other end.  

 Orient the pulley block nearest the saw as it would be when attached to the profile, and 

feed the belt through it.  

 Once the belt is through the bearing block, re-attach the block to the guide profile with the 

grub screw clamps. 

 Orient the motor side pulley block, complete with motor and mounting plate, as it would be 

when attached to the guide profile. 

 Feed the belt through the bearing block and re-attach the block, complete with motor and 

mounting plate, to the guide profile with the grub screw clamps. 

 Attach the belt to the trolley unit by means of the belt attachment blocks. 

 Set the tension of the belt by means of the tension adjusting grub screws in the attachment 

blocks, until the belt can just be pushed off the side of the guide profile.  Do not over 

tighten! 

 Replace the two 8mm cap head screws which attach the motor unit mount plate to the 

guide profile. 

 Turn the whole assembly right side up. 

 Place the fence back in its original location. 

 Fit the 16 cap head screws through the upright brackets into the guide profile. 

 Tighten the motor mounting screws. 

 Plug the two cables back into the servo motor. 

 Start the machine and follow the procedures for trolley calibration to ensure correct 

measurement. 
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10 Safe Operation 
NOTE: The Spida Rapid Stop is to be operated in accordance with this manual. Deviation from this 

specified operation may result in incorrect cutting, measuring or injury. 

10.1 User Warnings 
 The set face of the length stop unit must be set so as not to allow its movement through the cutting 

pressing area of adjacent machinery. 

 All machine and components should be inspected upon delivery and at weekly intervals for looseness, 
fracture, bends, sharp edges or surfaces and any other condition that may contribute to a human 
mishap or further deterioration of the machine.  We suggest a log be kept for this purpose. 

 When broken, damaged or loose parts (or any condition that may represent a hazard) are observed, 
corrective action should be taken immediately.  Inadequate attention to maintain the machine can 
cause the premature failure of these parts.  We suggest this information also be logged. 

 The electrical boxes should be locked at all times to avoid casual entry by unauthorized persons, as 
touching live surfaces is hazardous. 

 Split, broken, warped, twisted or timber with excessive wane should be avoided or used with caution 
because of the greater possibility of the timber not being held securely during manufacturing processes. 

 The machine is not to be used for any other purpose than the measuring of timber components. 

 Keep hands out of moving parts on the machine.  Operators should be instructed not to extend fingers 
or limbs into or beyond the vicinity of the warning labels.  The danger here is obvious – fingers in these 
areas will risk mutilation. 

 Be sure the machine is completely free of foreign objects and that all guards are in place before power 
up. 

 Any guards removed for maintenance or adjustments MUST be replaced before the machine is put back 
into service. 

 It is dangerous to exceed the capabilities of the machine. 

 Failure to perform the daily and weekly service checks as per the schedule may result in serious damage 
or a severe accident. 

10.2 Manual Handling 
 Ensure timber supply is via forklift or other support mechanism 

 Ensure correct lifting techniques are adopted to transfer material to infeed of cutting line 

 Suggest use of trolleys or bench at required height and location to minimize handling and twisting 

 Ensure required PPE is worn 

 Ensure correct and appropriate lifting techniques are used 

 Material supply via gravity roller transfer system 

 Avoid twisting torso when moving pre-cut members from transfer system to pressing surface of table 

 Only lift components of weight which you assess to be within your limit 

 Use machinery (forklift) for material decreed to be too heavy or ask for assistance from another 
worker 

 

 

 

 

  
WARNING! This machine must only be operated by personnel who have been 

properly instructed in all aspects of the machine’s safe operation. They must 

also be wearing the recommended protective clothing and have thoroughly read 

and understood this operation and service manual. 
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11 Hazard Identification 

11.1 Vibration 
The operator does not expect to encounter any vibration caused by the machine. 

11.2 Noise 
Hearing protection must be worn when operating or working near a saw. 

11.3 Suffocation and Asphyxiation 
The operator cannot be suffocated or asphyxiated due to lack of oxygen or atmospheric 

contamination.  Saw dust, especially from chemically treated timber, may cause respiratory 

problems. It is strongly recommended that the operators wear approved dust masks and adequate 

ventilation is provided. 

11.4 Slips, Trips and Falls 
There is the potential to slip, trip or fall if good housekeeping practices are not adhered to and the 

work area is not kept free of saw dust, loose timber, and off-cuts. 

11.5 Cleaning 
The machine must be isolated from the power and locked at the main power isolation switch before 

any cleaning or maintenance is to be performed.  The key is to be removed and kept by the 

personnel entering the cutting area. Gloves must be worn when handling sharp components to 

protect the hands from cuts or scratches 

11.6 Ergonomics 
The operator/s are required to be able to move freely around the front and rear of the machine for 

loading timber and removing the processed material.    

The machine working height can be adjusted. 

The machine cannot be operated while seated. 

The operator/s are not required to climb onto or enter behind the machine while the machine is 

operating. 

The operator/s must wear approved safety footwear, dust mask, eye protection and hearing 

protection. 

11.7 Guarding 
The machine MUST NOT be operated with any of the guards removed. The machine is fitted with 

steel guards. 

11.8 Access 
There is no requirement for the operator to access the confines of the machine during operations. 

Access to the cutting area for cleaning and maintenance must not be made unless the machine has 

been isolated from the power at the Main Power Isolation switch and the key removed. 

11.9 Personal Protective Equipment (PPE) 
Personal protective Equipment (PPE) is not supplied with this machine.  The employer or end user is 

responsible to ensure that the correct type of PPE is supplied, that it is properly maintained and that 

the user is trained in the correct fitting of the PPE. 



 
 

 
 
36                                                                                                                      Operations Manual – Rapid Stop 
 

11.10 Recommendations 
That the operator is trained, on induction of the dangers of accessing the machine operating area. 

The electrical system is to serviced, by a qualified electrician only.   

That all operators are walked through the operators’ manual and all potential hazards are identified. 

That good housekeeping is maintained at all times to avoid the risk of slips, trips or falls. 

That approved eye and hearing protection is used at all times when operating the machine.   

That approved dust masks and safety footwear are worn at all times when operating the machine.  

That if the machine is not operating as efficiently as specified, the operator notify their supervisor 

who in turn take appropriate action and eliminate the problem if possible. 

All guards and safety devices are not to be removed. 

It is recommended that a yellow line be painted on the floor on a one metre (1000mm) perimeter 

surrounding the working area of the machine. To identify the work space to pedestrians. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

WARNING! This machine must only be operated by personnel who have been 

properly instructed in all aspects of the machine’s safe operation. They must also 

be wearing the recommended protective clothing and have thoroughly read and 

understood this operation and service manual. 
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12 Foreseeable Misuse 
Through experience, SPIDA’s technical staff have listed (in order of occurrence) the most common 

misuses of the machinery by operators, the symptoms that result and the rectification required to 

address the misuse and return the machine to optimal working order. 

Table 9, Common misuse issues 

MISUSE SYMTOM RECTIFICATION REQUIRED 
Lack or Regular 
Calibration 

Creeping measurements 
Pushing the start button to calibrate the 
machine twice daily 

Stop face damaged 
by timber 

Sagging stop face may contact 
table or roller bed  

Tightening of support screws, retraining 
of operator 

Turning off the 
power prior to 
turning off the 
drives 

No operation or loss of control 
data 

Contact Spida to re-enter codes 

Wing timber for 
material 
movement 

Moving timber towards 
operator 

Don not use for material handling 

 

Any other misuse and resultant damage of the machine is deemed non-foreseeable as its occurrence 

is not consistent. 
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13 Distributor & Repairer Contacts 
 

13.1 Agent/Distributor 
Company Name: ____________________________________________________________________ 

                                                                                                                                                                                                                          

Contact Person:   ____________________________________________________________________ 

Ph.: _____________________________________ Fax: 

______________________________________ 

Mobile: _________________________________ Email:  ____________________________________ 

 

13.2 Automation Repairs 
Company Name: ____________________________________________________________________ 

Address:  __________________________________________________________________________ 

Contact Person:   ____________________________________________________________________ 

Ph.: _____________________________________ Fax: 

______________________________________ 

Mobile: _________________________________ Email:  ____________________________________ 

 

13.3 Mechanical Repairs 
Company Name: ____________________________________________________________________ 

Address:  __________________________________________________________________________ 

Contact Person:   ____________________________________________________________________ 

Ph.: _____________________________________ Fax: 

______________________________________ 

Mobile: _________________________________ Email:  ____________________________________ 
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14 Warranty 
SM2012 Ltd, SPIDA Machinery, Tauranga, New Zealand, warrants the equipment listed below to 

the initial purchaser of the equipment only against defective workmanship and materials only, for 

a period of twelve (12) months from the date of shipment from SPIDA's factory, subject to the 

following conditions: 

1. SPIDA extends the original manufacturer’s warranty to SPIDA on buy-in items such as 

motors, saw blades and air cylinders or other such buy-in items but does not add its 

warranty herein described to such items. 

2. This warranty only applies if: 

a. The attached copy of this warranty is signed by the initial purchaser and returned to 
SPIDA's address shown above within 14 days of shipment of the goods from SPIDA's 
factory. 

b. The equipment is installed by SPIDA or its licensed installer. 

c. Regular routine maintenance has been carried out on equipment in accordance with 
instructions in manual provided by SPIDA and proper housing and shelter provided 
for the equipment. 

d. The equipment is operated by competent personnel in accordance with the 
operating instructions set out in the manual provided by SPIDA and not otherwise. 

The equipment has not been subjected to alterations or repairs or dismantling 

without prior written approval of SPIDA. Any parts returned to SPIDA either for 

repair or consideration of a warranty claim consequent to an authorisation to 

dismantle must be shipped prepaid. 

.  SPIDA may, at its option, either repair or replace the defective part upon inspection 

at the site of the equipment where originally installed. The warranty does not cover 

the cost of freight, Labour or traveling for the removal or replacement of the 

defective parts, 

g. This warranty does not apply to any deterioration due to average wear and tear or 
normal use or exposure. 

h. In all warranty matters, including any question of whether this warranty applies to 
any claim, the decision of SPIDA is final, 

This warranty is the only warranty made by SPIDA as the manufacturer and is expressly in lieu of and 

excludes all other warranties, conditions, representations and terms expressed or implied, statutory 

or otherwise, except any implied by law and which by law cannot be excluded. Neither SPIDA or its 

agents or servants will be liable in any way for any consequential loss, damage or injury including 

any loss of use, profits or contracts. 

The law applicable to this warranty shall be the law of New Zealand and the parties hereto submit to 

the exclusive jurisdiction of the Courts of New Zealand. 
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Machinery/Equipment 

 

The item bearing the following serial plate: 

 

   _____________________________________ 

 

Date of Shipment: ______________________________________ 

Signed by:  ______________________________________ 

Name:   ______________________________________ 

Position:  ______________________________________ 

 

Acceptance of Warranty 

 

I acknowledge and accept the contents of this warranty. 

Signed by:  ______________________________________ 

Name:   ______________________________________ 

Company:  ______________________________________ 

Position:  ______________________________________ 

Date:   ______________________________________ 
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15 Electrical Drawings 
 

 

Figure 9, Electrical drawing 
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16 Training Certificate 
Instructor: ___________________________________ 

Company: ___________________________________ 

 

I declare that:  

 I have trained the person names below (“the trainee”) in the safe operation of the 

machinery/equipment detailed in the training manual. 

 The trainee has demonstrated an understanding of the safe operation of the 

machinery/equipment. 

 The trainee has indicated the he/she has read and understood this training manual. 

 

Signed:  ___________________________________ 

Date:  ___________________________________ 

 

 

Trainee: ___________________________________ 

Company: ___________________________________ 

Position: ___________________________________ 

 

I declare that: 

 I have received instruction from the person named above (“the instructor”) for the safe 

operation of the machinery/equipment detailed in this training manual. 

 All information in this training manual was demonstrated and explained by the instructor. 

 I have thoroughly read and understood this training manual. 

 

Signed:  ___________________________________ 

Date:  ___________________________________ 

 

Witnessed by: 

Name:  ___________________________________ 

Company: ___________________________________ 

Signed:  ___________________________________ 

Date:  ___________________________________ 


